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1 About this manual
Welcome to IBM® Rational® DOORS® for ClearCase Interface.
Rational DOORS for ClearCase Interface transfers data between Rational 
DOORS and ClearCase®. It lets you synchronize configuration management 
regimes and establish traceability between information managed in Rational 
DOORS and versions managed by ClearCase.
This manual describes how to use version 2.1.1 of Rational DOORS for 
ClearCase Interface. It assumes that you know how to use both Rational 
DOORS and ClearCase.

Typographical conventions
The following typographical conventions are used in this manual:

Related documentation
The following table describes where to find information in the documentation 
set:

Typeface or 
Symbol

Meaning

Bold Important items, and items that you can select, including 
buttons and menus. For example: Click Yes to continue.

Italics Book titles

Courier Commands, files, and directories; computer output. For 
example: Edit your .properties file.

> A menu choice. For example: Select File > Open. This means 
select the File menu, then select the Open command from it.

For information on See

How to use Rational DOORS The Rational DOORS documentation 
set

How to use ClearCase The ClearCase documentation set
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These documents are on the Rational Information Center at 
http://publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

How to install Rational DOORS for 
ClearCase Interface

Rational DOORS Installation Guide

For information on See
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2 Concepts
This chapter introduces Rational DOORS for ClearCase Interface and explains 
the concepts you need to understand before you use it:

• About Rational DOORS for ClearCase Interface

• About Rational DOORS for ClearCase Interface functions

About Rational DOORS for ClearCase Interface
Rational DOORS is the world’s leading tool for creating, structuring, and 
managing complex sets of requirements, such as those for a typical software 
development project. ClearCase from Rational Software Corporation is a source 
code control and configuration management system. 
Rational DOORS for ClearCase Interface is a bridge between these two 
products, enabling complete lifecycle traceability from requirements through to 
configuration management.
Rational DOORS for ClearCase Interface allows software project teams to:

• Establish traceability from Rational DOORS information to specific 
elements, branches or versions in ClearCase.

• Import release information from ClearCase to Rational DOORS.

• Import merge information from ClearCase to Rational DOORS.

• Import ClearCase attributes to Rational DOORS.

• Create Rational DOORS baselines to match ClearCase labels.

• Navigate through all ClearCase elements, versions and branches in one 
window.

• Generate complete reports on combined ClearCase and Rational DOORS 
configuration status.

About Rational DOORS for ClearCase Interface functions
Rational DOORS for ClearCase Interface provides two functions that are 
fundamental to integrating configuration management with lifecycle traceability, 
as follows:

• The ability to represent the configuration item structure stored in ClearCase 
as a Rational DOORS module.
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Each element, branch and version in a Versioned Object Base (VOB) is 
represented by a Rational DOORS object in a hierarchy that represents the 
complete version tree for the VOB. Merge hyperlinks are stored as Rational 
DOORS links.

Once you have represented the ClearCase configuration item structure in a 
Rational DOORS module, you can use regular Rational DOORS link 
functions to establish traceability from project information stored in 
Rational DOORS to the configuration items. For example, a ClearCase 
version object that implements a specific requirement can be directly linked 
to the corresponding Rational DOORS requirement object. This allows you 
to demonstrate conformance to requirements at source-code level.

• The ability to baseline Rational DOORS modules using the same labels and 
comments as the ClearCase data.

This operation uses another Rational DOORS module to store a list of 
labels that exist in each VOB, and to create baselines automatically for 
groups of modules. Each baseline is recorded in the Rational DOORS 
module, providing a configuration-management record of which Rational 
DOORS baselines relate to which ClearCase labels. This function also 
provides the important ability to create baselines for many Rational DOORS 
modules simultaneously.

These two functions create a unified approach to both traceability and 
information release control, resulting in full lifecycle traceability and rigorous 
configuration management.
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3 Importing from ClearCase
This chapter describes:

• Importing from ClearCase into Rational DOORS

• Viewing new information

• Understanding imported information

• Using Rational DOORS traceability

• Import exceptions

Importing from ClearCase into Rational DOORS
This operation reads the complete structure of a VOB into a Rational DOORS 
module, creating a Rational DOORS object for each element, version and 
branch. Properties, attributes and labels are also imported.
Access to ClearCase elements is controlled by views that determine which 
elements, branches and versions are visible. ClearCase provides dynamic and 
snapshot views, depending on whether you want the views to be updated 
automatically or manually. Views also control access to derived objects and 
view-private files.
For these reasons it is vital that you choose the correct view for your import 
operation. Although Rational DOORS for ClearCase Interface imports all 
versions and branches, it cannot import view-private files from all views, so you 
must decide which view to use if you want these to be imported.
Rational DOORS for ClearCase Interface uses Windows® drive letters to select 
views. You can either choose to use the Dynamic-views drive, normally M:, or 
a view representing a specific dynamic or snapshot view. The dynamic views 
drive allows you to select any view of any VOB without needing to choose a 
drive letter, simplifying the import operation.

Importing structures for the first time

You can choose to import into an empty module or into a module that already 
contains objects. Each VOB is always imported under its own top-level object.
Normally, you want to maintain your configuration item structure in a special 
module. However, you might want to store information for several VOBs in the 
same module. If you choose to do this, the new VOB is imported under a new 
top-level object at the end of the module.
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To import from ClearCase:
1. Open the target Rational DOORS module.

2. From the DOORSConnect menu, select ClearCase > 
Synchronize/import.
Note  A command prompt window (DOS box) is displayed 

briefly before the Import Structure window displays. 
This happens when Rational DOORS for ClearCase 
Interface is communicating with ClearCase, and occurs 
several times during the import process. Each time, the 
command prompt window disappears automatically 
when the process is complete.

3. If you want to import from a dynamic view, make sure that the Drive field 
contains the correct drive. M: is the ClearCase default.

4. Select the view in the View field.

5. Select the VOB in the VOB field. The Path field shows the composite path 
that you have created.

Only mounted VOBs and views are shown. If you do not see the VOB or 
view you want to import, click Close to quit Rational DOORS for ClearCase 
Interface, then use ClearCase to mount the required VOB and view. 

6. If you want to import from a snapshot view or a dynamic view mounted on 
a specific drive, select Specific view drive from the Type drop-down list.

7. Select the correct drive and VOB. The Path field shows the composite path 
that you have created.

Only mounted VOBs are shown. If you do not see the VOB you want to 
import, click Close to quit Rational DOORS for ClearCase Interface and 
use ClearCase to mount the required VOB.

8. Clear the Create merge links in box if you do not want to create Rational 
DOORS links representing ClearCase merge hyperlinks.

9. If you want to create links in the default link module, ClearCase Merges, and 
it does not exist, it is created automatically the first time you perform an 
import. In this case, go to step 11.

10. If you want to create links, but not in the default link module, click Select to 
display the Select Link Module window.

11. Select the link module you want to use, and click Select.
12. Click Import to start the import operation.
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Importing from ClearCase into Rational DOORS

Several command prompt windows appear briefly as the operation 
progresses.

When the import is complete, an import report is displayed.

The import report shows how many new items were created during the 
import, how many items were updated, how many were deleted and how 
many merge links were created. 

For information on how to use the report window functions, see “Viewing 
new information,” on page 8.

Re-importing structures
It is likely that your ClearCase data will continue to evolve after you have 
imported it into Rational DOORS. Rational DOORS for ClearCase Interface 
can synchronize imported data with the state of the ClearCase VOB, adding new 
elements, versions and links and updating attributes and labels as required.
To synchronize your imported data, select the Rational DOORS object 
representing the VOB to be re-imported and repeat the procedure in “Importing 
structures for the first time,” on page 5. This object appears at the top of the 
structure, usually the first object in the module. An import report is displayed, 
showing the number of items that have been created or updated.
If an item is deleted from the VOB, the equivalent object in the Rational 
DOORS surrogate module is flagged with the attribute CC Deleted set to True.
Items that are moved within the VOB, for example a source file moved from one 
directory to another are moved within the Rational DOORS surrogate module. 
This allows traceability to be maintained.

Imported attributes for structures
ClearCase data is stored in Rational DOORS attributes when it is imported. 
Attributes that store ClearCase data start with CC.
ClearCase properties are stored in the following attributes:

Attribute Contains

Object Heading The name of the ClearCase element. For a version this 
contains just the tail of the version name. For example, if the 
extended name of a version is: 
sysdef.c@@\main\windows\5 
the Object Heading attribute contains 5.
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Rational DOORS for ClearCase Interface also imports ClearCase labels and 
attributes. These are stored as Rational DOORS attributes and the values are 
kept with each Rational DOORS object.
If you have a ClearCase label Release_1, a Rational DOORS Boolean attribute 
called CC Label Release_1 is created. All versions that are marked with that 
label have the Rational DOORS attribute set to True. A simple Rational 
DOORS filter immediately shows which items belong to each release.
If you have a ClearCase attribute QA_Status, a Rational DOORS string attribute 
called CC Attr QA_Status is created. When an element, branch or version has a 
value for this attribute it is copied into the Rational DOORS attribute.
Rational DOORS for ClearCase Interface also creates three attributes to store 
import metadata: CC Deleted, CC New, and CC Updated. These are set each 
time you import or synchronize, and are the basis for the import report filters. 
You can create your own filters and views based on these attributes.

Viewing new information
Rational DOORS provides many useful ways of viewing imported ClearCase 
information. It has the advantage of being able to put all the relevant 
information into a single screen.

Object Text The ClearCase comment for the element, branch or version. 
This typically contains the comment from a source file 
check-in.

CC Kind The type of the object. Possible values are VOB, Directory, 
File, Version, Branch, Derived Object, or Private File.

CC Full Name The full version name of an item. In the example above this 
attribute would contain sysdef.c@@\main\windows\5.

CC User The name of the person who created the element, version or 
branch.

CC Date The date on which the element, version or branch was created.

CC Merges The full name of a version to which this version has been 
merged.

CC DBID The ClearCase database identifier for the item.

Attribute Contains
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Understanding imported information

Any updated information is clearly shown using the standard Rational DOORS 
change bars. After an import, new or updated items have their change bars set to 
red, but the rest of the objects remain unmodified.
In the case of a re-import, you can use the New items, Updated items and 
Deleted items buttons in the Import Report window to show only the items 
that were new, updated or deleted.
ClearCase information can also be shown in graphics mode, where colors are 
used to distinguish the different kinds of object. Merge links are clearly shown if 
you click View, then Show, then Graphics Links. This option is automatically 
switched on by the Graphics button in the ClearCase Import Report window.

Understanding imported information 
This section explains how to interpret the information and how to get the best 
from it.

Version structure

ClearCase version structures are represented as version hierarchies, written using 
an extended filename syntax, such as the following name:

lookup.c@@main\PERFORMANCE\5
This means that this is the fifth version of the file lookup.c in the PERFORMANCE 
branch. In ClearCase this structure can be seen graphically element by element 
when using the Version Tree utility.
Rational DOORS stores this information as a hierarchy of objects containing the 
names of the elements, branches and versions as headings, with check-in 
comments as the text.
The Rational DOORS graphics mode has the advantage over the ClearCase 
Version Tree because it can show many version trees at once.

Graphics colors
When each item is imported it is assigned a color for use in graphics mode. This 
helps provide instant visual recognition of the structure of your data.
The color allocations are as follows:

Kind Color

VOB Red

Directory Green
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ClearCase attributes
All user-defined ClearCase attributes are imported into Rational DOORS as 
string attributes with the same name, prefixed with CC Attr. For example, the 
ClearCase attribute Test_Status is called CC Attr Test_Status in Rational 
DOORS.
Attribute values are imported for all ClearCase elements, versions and branches. 
If the values of attributes are subsequently changed in ClearCase, the values in 
Rational DOORS are updated the next time the file is imported. 

Labels
ClearCase labels are typically used to mark which files were included in a 
particular release. Labels have names, such as Patch_1.1. The import process 
creates a Boolean label for each imported label, prefixing the label name with CC 
Label. For this example, the Boolean label would be CC Label Patch_1.1.
Each version that is labeled with a given name, has the Rational DOORS 
attribute set to True. This can be used in filters, and gives instant indications of 
what versions were used in a given release.

Merge links
ClearCase uses hyperlinks to indicate where files have been merged. These can 
be imported into Rational DOORS as regular Rational DOORS links. This 
import process is optional, and can be turned off using the Create merge links 
check box.
Links are created from the version to the one it is merged with, typically from a 
branch to the main stream. This is equivalent to the direction of the ClearCase 
hyperlinks.

File Blue

Version Light blue

Branch Yellow

Derived Object Pink

Private File Orange

Kind Color
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Using Rational DOORS traceability

The best way of viewing merge links is to turn on the display of graphics links by 
clicking View, then Show, then Graphics Links. Alternatively, all the normal 
Rational DOORS link viewing and analysis mechanisms are available.

Using Rational DOORS traceability
Once imported into Rational DOORS, the ClearCase structure can be treated as 
normal in Rational DOORS. This means that the ClearCase structure can be 
included in your traceability schema. A typical application of this is to link source 
code modules to requirements in order to check which requirements have been 
met. This is only one case where traceability could be useful, as outlined below.

Managing links

You can use any of the standard methods for creating links between ClearCase 
configuration items and other Rational DOORS information: 

• Drag and drop

• Link > Create links
• Link module matrix

In each case you must take into account the correct direction for links to allow 
impact and traceability analyses to be performed as required. These analyses can 
be performed using the standard tools:

• Pop-up menus

• Analysis > Impact or Analysis > Trace
• Layout DXL

• Analysis > Wizard
The Analysis Wizard is particularly good for creating customized traceability 
reports. With this, you could create a report that shows the relationship between 
change requests and code check-ins, showing complete version names in the 
context of the change requests.
Links can be deleted using any of the standard techniques.

Applications of imported structures

Rational DOORS can be used to store any kind of structured information, so it 
is likely that you already have information that can be usefully linked to the 
configuration items. In addition to the classic application of requirements 
traceability, you can also build links from change requests, bug reports, design 
information, test plans and project plans to ClearCase versions.
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Once in place, you can demonstrate that specific changes have been 
implemented, or create reports that justify all checked in changes.
Another application is the creation of complete product manifests. Using the 
Rational DOORS export functions, you can create documents in Word, HTML 
or any other supported format, that lists the document version included in a 
shipment.

Import exceptions
The Rational DOORS for ClearCase Interface import process is designed to 
import the information that you need most in your Rational DOORS-based 
lifecycle traceability scheme. To this end there are some items that are not 
imported. Two items that are deliberately not imported are listed below.

• Any version that is checked out is not imported until it is checked in. Any 
item that would be selected only with a \CHECKEDOUT configuration 
specification rule is specifically ignored. If a checked in item has been 
merged with an item that is still checked out the CC Merges attribute 
contains the reference; for example \main\CHECKEDOUT. However, 
no Rational DOORS link is created until the merge target is checked in. 

• Versions of directory elements are not imported. Rational DOORS for 
ClearCase Interface only imports from the directories that are selected by 
the configuration specification of the view from which you import.

Private files and derived objects from multiple views can be imported by 
repeating the import process from those different views. If there are several 
elements of the same name, Rational DOORS for ClearCase Interface has no 
way of distinguishing them; it then considers each private one an update of an 
earlier import.
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4 Labelling Rational DOORS baselines
This chapter describes:

• Importing ClearCase labels into Rational DOORS

• Creating Rational DOORS baselines

• Understanding results

• Using Rational DOORS traceability

Importing ClearCase labels into Rational DOORS 
ClearCase labels are typically used to mark which files were included in a 
particular release. Labels have names, such as Release_3, which can be attached 
to versions of ClearCase elements. Labels can be attached to any version, and do 
not restrain in any way the numbering system.
Rational DOORS baselines create frozen versions of modules that are similar to 
checked-in versions of files: they can be referenced, but not changed. Baselines 
are numbered progressively using major and minor versions, plus a textual suffix.
ClearCase labels are ideal for use as Rational DOORS baseline suffixes, where 
they can be used for the same purpose as in ClearCase. This is the main function 
of the Rational DOORS for ClearCase Interface baseline labelling function.
Baseline labelling is a two-step process: importing labels and creating baselines. 
The import process sets up a structure where a record of each created baseline is 
kept. This section describes the import step while the section “Creating Rational 
DOORS baselines,” on page 15 describes baseline creation.
Even though labels are directly related to a VOB, access to ClearCase is still 
controlled by views. For these reasons you must choose a view for your import 
operation.

Importing labels for the first time

You can choose to import into an empty module or into a module that already 
contains objects. The set of labels from each VOB is always imported under its 
own top-level object.
Normally, you would maintain your label and baseline structure in a special 
module, though you might choose to store label information for several VOBs in 
the same module. If you choose to do this, the new VOB will be imported under 
a new level one object at the end of the module.
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It is advisable not to store label and baseline information in the same module as 
the imported ClearCase configuration structure.
To import labels from ClearCase:
1. Log in to Rational DOORS as a Database Manager, a Project Manager, or a 

Custom user with the power to archive data.

2. Open your target Rational DOORS module.

3. Select DOORSConnect > ClearCase > Label baselines.

A command prompt window (DOS box) is displayed briefly before the 
Import ClearCase Labels window is displayed. This occurs when Rational 
DOORS for ClearCase Interface is communicating with ClearCase.

If you want to import from a dynamic-view make sure that the Drive field 
contains the correct drive. M: is the ClearCase default.

4. Select the view in the View field.

5. Select the VOB in the VOB field. The Path field shows the composite path 
that you have created.

Note  Only mounted VOBs and views are shown. If you do 
not see the VOB or view you want to import, click Close 
to quit Rational DOORS for ClearCase Interface, then 
use ClearCase to mount the required VOB and view.

6. If you want to import from a snapshot view or a dynamic view mounted on 
a specific drive, select Specific view drive from the Type drop-down list.

7. Select the correct drive and VOB. The Path field shows the composite path 
that you have created.

Note  Only mounted VOBs are shown. If you do not see the 
VOB you want to import, click Close to quit Rational 
DOORS for ClearCase Interface, then use ClearCase to 
mount the required VOB.

8. Click Import to start the import operation.

A command prompt window appears briefly.

9. When the import is complete, the Rational DOORS module is updated and 
the Apply Label to Modules window is displayed. For further information, 
see “Creating Rational DOORS baselines,” on page 15.
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Creating Rational DOORS baselines

Re-importing labels 

It is likely that after you have completed this baseline labelling operation you will 
create more ClearCase labels. For this reason, Rational DOORS for ClearCase 
Interface can synchronize existing imported labels with the state of the 
ClearCase VOB, adding new labels as required.
To do this, select the VOB object at the top of the label and baseline structure, 
then repeat the procedure in “Importing labels for the first time,” on page 13.

Imported attributes for labels
ClearCase data is stored in Rational DOORS attributes when it is imported. 
Attributes that store ClearCase data start with CC.
ClearCase properties are stored in the following attributes:

Creating Rational DOORS baselines
The second step of the import process is the creation of Rational DOORS 
baselines using an imported ClearCase label.
You create baselines using the ClearCase Apply Label to Modules dialog box.
To create labeled baselines: 
1. Ensure all necessary Rational DOORS modules are closed and not in use by 

others.

2. Select the required label from the list in ClearCase labels.
3. Select the required module from the list in Rational DOORS modules. 

You can select any number of modules in this list. Use Select all and Clear 
all to simplify the selection process if you have a lot of modules.

Attribute Meaning

Object Heading The name of the ClearCase label.

Object Text The ClearCase comment for the label, specified when the 
label was created.

CC Kind The object type. Possible values are VOB, Label and 
Baseline.

CC User The name of the person who created the label.

CC Date The date on which the label was created.
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4. Select the type of baseline required: Suffix only, Minor or Major version.

5. Select whether you want to include a suffix by clicking Use suffix. The 
default suffix is the selected ClearCase label. You can modify it before use if 
required.

6. Modify the label comment, if necessary. It is used as annotation for the 
baseline.

7. Click Baseline. You are asked to confirm the operation twice. To create the 
baseline, Rational DOORS needs to open all the selected modules in 
exclusive edit mode. This means you must make sure that no one else has 
any of the modules open in either exclusive or shareable edit modes. 

Once a baseline has been created, it cannot be destroyed or recreated, so you 
must be absolutely certain that a group baselining operation is correct before 
proceeding. 
Baselines are created for each of the specified modules, and the label module is 
updated to contain a baseline-creation object for each module. 
The attribute CC Baseline is created and filled with the baseline name for each 
baseline creation object.
When the baseline creation is complete, a Baseline Labelling Report dialog 
box is displayed, showing how many labels and baselines were created.
For further information on how to use the Baseline Labelling Report window 
functions, see “Understanding results,” on page 16.

Understanding results
All the normal Rational DOORS viewing mechanisms can be used on the label 
and baseline structure. The information can be displayed in either document or 
graphics mode. Each object type has been allocated a color to aid visual 
identification.

Graphics colors
When each item is imported it is assigned a color for use in graphics mode. This 
helps provide instant visual recognition of the structure of your data.
The color allocations are as follows:

Kind Color

VOB Red
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Using Rational DOORS traceability

Viewing new information 
If you re-import labels or create new labels in the same module, you can use the 
Apply filter button on the Baseline Labelling Report dialog box so that only 
the new items are displayed.

Using Rational DOORS traceability
By storing information on labels and baselines in a Rational DOORS module, 
they can be included in your traceability schema. In this way you can link details 
of released information directly to project plans and other applications, as 
outlined below.

Managing links
You can use any of the following standard methods for creating links between 
label and baseline objects and other Rational DOORS information:

• Drag and drop

• Link > Create links
• Link module matrix

In each case you must take into account the correct direction for links to allow 
impact and traceability analyses to be performed as required. These analyses can 
be performed using the following standard tools:

• Pop-up menus

• Analysis > Impact or Analysis > Trace
• Layout DXL

• Analysis > Wizard
The last item, the analysis wizard, is particularly good for creating customized 
traceability reports. With this, you could create a report that shows the 
relationship between code check-ins and module baselines, showing complete 

Label Green

Baseline Blue

Derived Object Pink

Private File Orange

Kind Color



Labelling Rational DOORS baselines

18    Using Rational DOORS for ClearCase Interface

version names, baseline specifications, and dates in the context of planning 
information.
Links can be deleted by using any of the standard techniques.

Applications of imported labels 
Rational DOORS can be used to store any kind of structured information, so it 
is highly likely that in your data you already have information that can be linked 
to baseline records. You might use it to associate particular module baselines 
with deliveries made to customers with specific requirements. 
Another application is to create complete product manifests. Using the Rational 
DOORS export functions, you can create documents in Word, HTML or any 
other supported format, that lists the document version included in a shipment.
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5 Troubleshooting
• Poor performance when importing data to Rational DOORS

Poor performance when importing data to Rational DOORS
When importing data from ClearCase into Rational DOORS, the operation may 
take a long time and may appear to hang.
To resolve this problem, do the following before importing:

1. Open up Windows Task Manager.

2. Go to the Processes tab.

3. Right-click on the DOORS.exe process and for the Set priority menu 
option, click low.

4. Try the operation in the integration again.

5. Once the import operation has finished, set the priority of the process back 
to normal.
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6 Contacting support
This chapter contains the following topics:

• Contacting IBM Rational Software Support

• Prerequisites

• Submitting problems

• Other information

Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM Rational Software Support for assistance in resolving product 
issues.

Note  If you are a heritage Telelogic customer, you can go to 
http://support.telelogic.com/toolbar and download the 
IBM Rational Telelogic Software Support browser toolbar. 
This toolbar helps simplify the transition to the IBM Rational 
Telelogic product online resources. Also, a single reference 
site for all IBM Rational Telelogic support resources is 
located at 
http://www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html.

• To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_
quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:
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• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to 
http://www-01.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.

Use the following table to determine the severity level.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers 
to these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 

Severity Description

1 The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2 This problem has a significant business impact: The program 
is usable, but it is severely limited.

3 The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4 The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
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Submitting problems

• Start the IBM Installation Manager and click File > View Installed 
Packages. Expand a package group and select a package to see the 
package name and version number. 

• Start your product, and click Help > About to see the offering 
name and version number. 

• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to 
http://www-01.ibm.com/software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/.
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If the problem you submit is for a software defect or for missing or inaccurate 
documentation, IBM Rational Software Support creates an Authorized Program 
Analysis Report (APAR). The APAR describes the problem in detail. Whenever 
possible, IBM Rational Software Support provides a workaround that you can 
implement until the APAR is resolved and a fix is delivered. IBM publishes 
resolved APARs on the IBM Rational Software Support Web site daily, so that 
other users who experience the same problem can benefit from the same 
resolution.

Other information
For Rational software product news, events, and other information, visit the 
IBM Rational Software Web site on http://www.ibm.com/software/rational/.
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7 Notices
© Copyright IBM Corporation 1993, 2009
US Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user’s responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to:  
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
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THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact:  
 
Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
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Trademarks

may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
Additional legal notices are described in the legal_information.html file that is 
included in your software installation.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www.ibm.com/legal/copytrade.html.
Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both.
Other company, product or service names may be trademarks or service marks 
of others.
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